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Introduction

► What is a claims review?

► Why should an actuary consider requesting one?

► Who in the audience has been involved in one?
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Overview

1. Trigger for a claims review from the actuary’s perspective
B i f l i i2. Basic process for a claims review

3. How to consider findings in actuarial analysis 
4 Potential value of claims review beyond the actuarial4. Potential value of claims review beyond the actuarial 

review 
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Triggers for a claims review 
from an actuary’s perspective

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial reviewy p p

► Several possible triggers exist that you can be looking for

► Findings from questioning of claims department or TPA

► Data diagnostics performed before or during the analysis

► Unexplained adverse of favorable development► Unexplained adverse of favorable development

► These things are often elementary, but may not be viewed 
through the lens of a possible claims review
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Findings from questioning 
with claims department/TPA

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial reviewp

► Asking the right questions early on can point to issues
► What specific objectives and guidelines does your department have in► What specific objectives and guidelines does your department have in 

setting unpaid case?
► Have there been any significant changes in the guidelines for setting and 

reviewing unpaid case during the last year(s)?g p g y ( )
► Are any special procedures or guidelines applied in the reserving of large 

or catastrophic claims? If so, please describe.
► Has the size of the caseload of the average claims adjuster changed 

significantly in the past several years?
► When, in the sequence of events, is a claim file established?
► Have there been any noticeable changes in the rate of settlement of 

claims recently?
► Has there been any shift from the employment of company adjusters to 

independent adjusters?
C ld id i f t l i dit ?
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Data diagnostics 1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial review

► Take the time to perform the traditional data diagnostics 
every year and do so early in the processevery year, and do so early in the process

► Two general types of diagnostics► Two general types of diagnostics
► Loss and claim count diagnostics
► Average claim diagnostics

► Review for consistency relative to your claims interviews
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Data diagnostics 1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial review

► Loss and claim count diagnostics

► Ratio of paid-to-reported claims: may indicate changes in case 
outstanding adequacy or settlement patterns

► Ratio of paid claims to on-level earned premium: may indicate 
changes in speed of claims payment or in underwriting results

► Ratio of closed-to-reported claim counts: may indicate 
changes in the settlement rate of claims

► Important: Understand any changes in deductibles, limits, 
coverages or mix of business/claims
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coverages, or mix of business/claims



Data diagnostics 1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial review

► Average claim diagnostics (inflationary trends expected)
► Average reported claim (report loss/reported claim count):► Average reported claim (report loss/reported claim count):

may indicate either changes in payments or case outstanding

► Average paid claim (paid loss/closed claim count): may 
indicate change in payment speed

► Average case outstanding (case/open claim count): may 
indicate change in case reserve adequacy

► Important:
► Understand definition of reported and closed claims (may have $0 claims)
► Beware of large claims that may distort diagnostics (either remove or limit)

Complementing an actuarial review with a claims reviewPage 9

► Beware of large claims that may distort diagnostics (either remove or limit)



Unexplained adverse or 
favorable development

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial reviewp

► Performance of an “actual vs expected” or “hindsight” 
analysis at each review may also be a triggeranalysis at each review may also be a trigger

► Consistent adverse or favorable development could be► Consistent adverse or favorable development could be 
indicative of a shift in claims practices, or in a mismatch 
between assumptions and exposure being analyzed

► Beneficial to review experience not just in total for each 
class but by accident year as wellclass, but by accident year as well

► The result of the claims review may also help you decide 
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Understanding the review triggers –
baseline operational review

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial review

► Who is the client?
Wh t i d i i th t i t?► What is driving the current environment?

► High-level Client Operational Review – Establishing a 
BaselineBaseline
► Organizational changes
► Loss trends

L l f i k t ti► Level of risk retention
► Loss allocation methodology
► Divisional/location structure
► Workforce analysis
► Client staffing & expertise/Roles & responsibilities
► Internal claim management guidelines
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► Internal claim management guidelines



Understanding the review triggers –
baseline operational review

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial review

► Agreed Reason for Claims Review
► Audit or review?► Audit or review?
► In most cases, review should focus on vendor leading practices in 

claim management

► Claims Vendor - Program Review
► Length/depth of program with client
► Pricing/incentives► Pricing/incentives
► Special account instructions
► Vendor interviews
► Vendor stewardship► Vendor stewardship
► Vendor claim management leading practices 
► Vendor stability
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Deeper dive into the claims 
metrics

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial review

► Program Trending
► Overall + rate adjusted where available► Overall + rate-adjusted where available
► Frequency
► Severity
► Lost Work Days/OSHA
► Corporate, divisional, key locations

► Key Vendor Metrics► Key Vendor Metrics
► Claim closure
► Expense management
► Indemnity vs. Medical

► Vendor Performance
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Establishing guidelines and 
logistics; setting expectations

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial review

► Finalize Goals of Review
D th f R i► Depth of Review

► Client Involvement
► Vendor Involvement► Vendor Involvement
► Determine Expected Output of Review

► Report
► Metrics
► Action planning
► Corrective Action/Follow-Up► Corrective Action/Follow Up

► Logistics
► Timetable
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Building or choosing the 
review tool 

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial review

► Review Tool Format
► Usually Access based► Usually Access-based
► Pre-populated with claim selections
► Should allow for pre-formatted reporting based on findings

► Review Tool Content
► Focus areas
► Baseline questions by coverage line► Baseline questions by coverage line
► Ability to modify based on specific client needs/goals
► Weighting element – Scoring

► Review Tool Example
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Review Tool – Screen Shot 
Sample

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial reviewp
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Claim selection process 1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial review

► Claim Selection – Statistical Significance
F d S l ti A d P t► Forced Selection – Agreed Parameters
► Open or closed
► Age of claimg
► Type of claim
► Severity of claim
► Jurisdictional representation► Jurisdictional representation
► Business unit representation
► Vendor claim office representation
► Litigated claims

► Vendor Involvement/Cooperation
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Inside the claim review 1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial review

► Pre-Audit/Team Consistency
Q lit A► Quality Assurance

► Location of Review
► Vendor► Vendor
► Client
► Remote/Web

C l Cl i R i & C► Complex Claim Review & Concurrence
► Daily Team Discussion/Wrap-Up
► Notes/Trends► Notes/Trends
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Communication with key 
stakeholders

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial review

► Project Kick-Off
Cli t I l t► Client Involvement

► Vendor Communication/Feedback
► Daily issue discussion► Daily issue discussion
► Claim-specific concerns/questions
► Jurisdictional or expert guidance

A t i l/B T C i ti► Actuarial/Base Team Communication
► Preliminary Audit Results 
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Report & Metrics 1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial review

► Instant Reporting – Quantitative Results
Fi l Q lit A► Final Quality Assurance

► Detailed Written Report Interpreting Findings
► Review results by category claim office overall► Review results by category, claim office, overall
► Key qualitative trends
► Identify Improvement opportunities for vendor, client

S t d ti l /t i i d d► Suggested action plan/training needed

► Additional Review Needed?
► Review Results Tied Back to Key Metrics► Review Results Tied Back to Key Metrics
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Process Improvement and 
ongoing review process

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial reviewg g p

► Key Review Findings
V d F db k► Vendor Feedback

► Additional or Deeper Review/Audit Required?
► Identify Specific Action Steps/Training► Identify Specific Action Steps/Training 

► Vendor
► Client

► Quantify Value of Improvement – Metrics & Actuarial 
Impact

► Timelines for Next Steps► Timelines for Next Steps
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May suggest adjustments or 
partitions of the data 

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial reviewp

► The claims review may indicate that subsets of the 
exposures are driving significantly different results from aexposures are driving significantly different results from a 
claims perspective
► State differences
► Class differences

► Or specific individual claims may be identified as unique► Or, specific individual claims may be identified as unique 
and subject to different development behavior
► Latent claims (asbestos, environmental, construction defect)
► Large losses at limit
► Hurricane losses
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May provide assumptions or 
sources of assumptions

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial reviewp

► Expected loss ratios
► May indicate which historical period should be relied on► May indicate which historical period should be relied on
► May be a basis for making an adjustment to industry
► May be a basis for making adjustments to current year

► Loss development patterns
► Again, may indicate which historical period to rely on► Again, may indicate which historical period to rely on
► May result in exclusion of some specific claims
► May result is restatement of case reserve levels (e.g. B-S)

► Also, often valuable to get claims input on reasonability of 
assumptions, especially if relying on industry
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May suggest which methods 
are more appropriate

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial reviewpp p

► Consistency of settlement and case reserving practices 
may point you towards one method or anothermay point you towards one method or another

► In cases where methods are deemed not reliable, claims► In cases where methods are deemed not reliable, claims 
input may allow for adjustment and improvement

► In cases where there are a limited number of open claims 
and limited potential for additional reporting, the claims 
review may yield an actual IBNR estimate to considerreview may yield an actual IBNR estimate to consider
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May inform on the reasonable 
width of the range

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial reviewg

► Often times an actuary’s range is based on a benchmark 
width or rule of thumbwidth or rule of thumb

► Discussion of these low and high IBNR estimates with the► Discussion of these low and high IBNR estimates with the 
claims professional may indicate that one of the ends of 
the range is not realistic or reasonable

► In cases where different “reasonable” assumptions and 
methods were used to determine range claims input onmethods were used to determine range, claims input on 
low and high assumptions and methods can be 
considered, as was discussed on the last two slides
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Window into client 
organization

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial reviewg

► Identify Client Issues
► Verify trends identified in actuarial analysis► Verify trends identified in actuarial analysis
► Claim reporting
► Return-to-work
► Medical provider relationships
► Vendor relationships
► Divisional/location issues► s o a / ocat o ssues
► Union – employee relations issues
► Guidelines/changes needed?
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Identify vendor 
improvement opportunities

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial reviewp pp

► Quantify Critical Claims Vendor Issues
► Account instruction compliance► Account instruction compliance
► Data quality
► Data security
► Reserving accuracy
► Quality of field office claim staff
► Claim supervision & field office management► C a supe s o & e d o ce a age e t
► Process vs. rigor
► Claim leakage

V d C it t t Cli t► Vendor Commitment to Client
► Introduce Formal Claim Review/Audit Process
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Opportunity to introduce performance and 
outcome-based metrics into the organization, 
centered around loss-cost mitigation

1. Trigger for a claims review from the actuary’s perspective
2. Basic process for claims review
3. How to consider findings in an actuarial analysis
4. Potential value of claims beyond the actuarial review

► Create Value for Client
► Outcomes-based Metrics

► Loss-cost reduction
► Rate-adjusted metrics
► Ability for claims vendor to impact► Ability for claims vendor to impact

► Vendor Contracting – Procurement
► Performance guarantees/incentivesg
► Loss costs – overall severity, lost work days, medical $
► Outcomes vs. process
► Penalty/bonus► Penalty/bonus
► Timing/length of measurement

► Build Long-term Partnership
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